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Welcome to TeleView software.  TeleView is an all-new way to let clients view your 
transcript in realtime.  Your clients will not need any special software to access 
TeleView.  All they need is a computer with Internet access and a browser. 
 
 
TeleView Installation 
 

1. Before installing TeleView, close any open programs and confirm that the HASP 
key is on the computer. 

  
2. Insert the Total EclipseM CD into the CD/DVD drive.  An install screen should 

open momentarily.  If it does not, click the Start button and choose Run from the 
menu that appears.  Once the Run dialogue box appears, enter“D:\install.exe” 
into the text box (substitute the location of your CD-Rom drive for “D,” if it is 
different).  

  
3. When the Advantage Software install screen appears, click TeleView. 

 
4. When the first TeleView installation screen appears, click Next to begin the 

installation process. 
 

5. On the next screen, you will be required to accept the Advantage Software license 
agreement.  After reading the agreement, click I Agree to continue the installation 
process. 

 
6. You will now be asked to choose the location for TeleView installation.  It is 

recommended that you install TeleView in the default file folder.  The default 
folder for TeleView installation is C:\Program Files\ TeleView3.  Once you 
have chosen the installation location, click Next. 

 
7. From the next screen, you will choose the location on the Start Menu where your 

TeleView icons should be located.  The default location is TeleView V3 and we 
recommend you choose this location for your shortcuts.  Once you have chosen a 
location, click Install. 

 
8. An installation screen will then briefly appear while TeleView installed.  Once the 

installation is complete, a new screen will appear automatically stating that 
TeleView has been installed successfully.  Now click Finish to complete the 
installation process. 



If you are installing Total EclipseM for the first time, the TeleView software will be 
activated when you activate the translation key.  If you are installing Total EclipseM to 
update your software, or installing TeleView without updating Total Eclipse, you will 
need to call Advantage Software at 800-800-1759 to have the key programmed for use 
with TeleView.  Once you have activated your key, you are ready to begin using 
TeleView. 
 
 
Getting Started with TeleView 
 

TeleView consists of two parts, the TeleView 
server on the Reporter or CART provider’s 
computer and the TeleView viewer located on the 
client’s computer.  
This manual will 
guide you through 

the process of setting up the TeleView server on your 
computer.  It will also provide you with information on the 
options available on the server, as well as the TeleView 
viewer. 
 
Starting Realtime 
 

To start a realtime job in Total Eclipse, 
go to the Production menu and select 
the User Settings option.  The user 
settings box will open, allowing you to 
setup the output format for jobs where 
TeleView is in use.  You will only 
need to do the setup once.  To setup 
the output format, go to the Realtime 
tab and click Add.  This will open the 
dialogue box that will allow you to 
select the settings for the output 

format.  For the new output format, the correct settings are to set the Output Format to 
Bridge/LawBridge/TeleView and the Comm Device to File Sharing.  At this point, 
click Setup and choose the location where your 
translation document will be saved.   

Once the user settings are correct, return to the 
Production menu and select the Translate option.  
Under translate notes, set the translation mode to 
Realtime, place a checkmark next to Enable Output 
and click Ok.  After you click Ok, you will be asked to 
choose the file you plan to use for translation.  At this 



point, you may choose to use an existing Eclipse (*.ecl) file or create a new file to use for 
this session.  Once a file is chosen, your realtime job will begin and you are ready to 
setup the server. 
 
 
Server Setup 

 
To setup the server, open TeleView and 
associate the LawBridge (*law) file 

created by Total Eclipse with the TeleView server.  To associate the file with the server, 
click Browse, locate the LAW file with same name as the file being translated and 
double-click on the file.  The file will remain associated with the server as long as the 
server is open. 
 
Under I.P. Address at the top of the server, you will see 
a Port field.  The default setting for this field is 80.  
Unless your clients encounter problems connecting to the server, this should not be 
changed.  If your clients experience problems connecting to the server, please consult the 
troubleshooting section of this manual for some possible causes and solutions. 
 

The TeleView server is equipped with 
password protection.  Using password 

protection provides transcript security by limiting access to the server.  Clients will be 
required to enter a username and password before being connected to the server.  The 
password, which must be at least four characters, can be set by going to the Password 
field and entering the password of your choice.  The password may consist of letters, 
numbers or a combination of the two.  The password is not case-sensitive.  If you forget 
to set the password, the server will use the default password.  The default password is 
“test”. 
 
Once the output file has been associated with the server and password protection set up, 
you are ready to begin running the server.  In the bottom left hand 
corner of the server, you will see a Run Server button. Click this 
button to start the server.  Once the server has started, your clients 
may begin connecting to it. 
 
If you are experiencing problems setting up the server, please look under 
Troubleshooting at the end of this manual or call Advantage Software at 800-800-1759. 



Server Options 
 
The default settings for the TeleView server will allow you to run TeleView without ever 
changing any of the available options.  However, TeleView also provides you with the 
option of changing the appearance settings from the server.  These changes can be made 
at any time.  However, they will only be transmitted to users who connect after you have 
made changes. 
 

To make changes to the appearance 
options from the TeleView server, 

click the Set Options button on the server.  A dialogue box will open 
allowing you to change the settings for the Right Margin Hint, 
Foreground Color, Background Color, Highlight Bar Color, 
Question Label Color, Answer Label Color and Speaker Label 
Color. 
 
 
 

Server Option Purpose 
Right Margin Hint The right margin hint number is the 

number of character on a single line of the 
transcript The right margin hint helps 
determine the appropriate font scaling 
based on screen size.   

Foreground Color Determines the default font color for the 
TeleView viewer. 

Background Color Determines the default background color 
for the TeleView viewer 

Highlight Bar Color Determines the default color for the 
highlight bar on the TeleView server.  The 
highlight bar replaces the cursor on the 
TeleView server. 

Question Label Color Determines the default color of the 
question label on the TeleView viewer. 

Answer Label Color Determines the default color of the answer 
label on the TeleView viewer. 

Speaker Label Color Determines the default color of the speaker 
label on the TeleView viewer. 

 
With the exception of the Right Margin Hint, each of these settings can also be changed 
via the TeleView viewer.  The Right Margin hint can only be changed via the TeleView 
server 



 
One of the features available with TeleView is the option 
to allow clients to save ASCII and HTML versions of 

the transcript.  To make a copy of the ASCII and HTML files available to the client, click 
on the ASCII/HTML Not Available button on the TeleView server.  You can choose to 
make these files available at any time.  Even if you choose not to make the ASCII or 
HTML file available, your clients will still be able to save a copy of their notes using the 
Save Notes feature. 
 
Connecting to Server 
 
Your clients will need the server address, in order to 
connect to the server.  This address can be found next to 
I.P. Address in the top left hand corner of the server and will look similar to this: 
235.189.138.56.  Everyone that intends to connect to the server will need this 
information.  The I.P. Address is assigned by the server and cannot be changed. 

 
Some computers, depending on the computer’s setup, 
may have more than one valid I.P. Address.  Therefore, 
server itself, may not be the one to which information is 

being sent.  TeleView has an option, which allows you to 
confirm that the I.P. Address shown on the server is valid.  
To confirm that the address shown on the server is valid, go 
to the Tools menu and choose Check I.P. Address.   Another 
window will open displaying the active I.P. Address.  This is 
the address you will need to give your clients.  
 

the I.P. Address displayed on the 

very client wishing to view your transcript will need to enter the I.P. Address of the 

When the attempt is made to access your TeleView 

 

E
server in to their browser’s address field.  The I.P. Address must be entered with http:// in 
front of the address.  Using the example above, if the I.P. Address were 235.189.138.56, 
it would need to be entered into the browser as http://235.189.138.56.  (If you are using a 
port other than port 80, your clients will need to include the port number when entering 
the I.P. Address.  For example, if your port were port 1234, then the address should be 
entered as http://235.189.138.56:1234.)  The browser will then be directed to a web page 
containing the viewer applet.  It is from this page that your clients will access the server 
and view your realtime transcript.  
 

server, the client will receive a message that “the 
application’s digital signature cannot be verified.  Do you 
want to run the application?”  When the message appears, 
the client should click Run.  Your clients will then be 
asked to enter a username (each client 
will choose their own, normally their 
full name) and password (you will 
with the password) in order to be need to provide each client



connected to the server.   Once the clients have entered their username and password, 
they will be connected to the server and the TeleView viewer will open. 
 
The TeleView viewer allows your clients to view the transcript in realtime.  There are 

ranscript Features

several transcript and viewer options available with the TeleView viewer, which will 
make TeleView a very valuable tool for your clients.  Transcript options include the 
availability of ASCII and HTML files, the ability to conduct word searches, make notes 
and mark lines.  The viewer options include changing font type, size and color, changing 
background color, and Chatback. 
 
T  

 the reporter or CART provider chooses to make them available, clients will have the 

o save a copy of the ASCII file, go to the viewer’s 

references to the lines where the no

o save a copy of the HTML file, go to the viewer’s File menu, choose Save All and then 

ork “mark”, to jump from mark to mark. 

 
If
option of saving ASCII and HTML copies of the transcript.  If the reporter or CART 
provider chooses not to make these options available, the client will still have the option 
of saving a copy of any notes they made. 
 

T
File menu, choose Save All and then choose ASCII.  
Your client will then need to choose a name for the 
file, choose the location where the file should be 
saved and click Open.  The ASCII will then be saved 
to the chosen location.  The client will find all of their 
notes at the bottom of the ASCII file along with 
tes were made. 

 
T
choose HTML.  Your client will then 
need to choose a name for the file, 
choose the location where the file 
should be saved and click Open.  The 
HTML file will contain all of the notes 
and marks made by the client.  Lines 
with related notes will have the word 
“note” next to that line.  The word 
“note” will then be hyperlinked to the 
note itself, which is located at the 
bottom of the HTML file.  The note at 
the bottom of the HTML file is also 
hyperlinked to the related line within 
the transcript.  Each line that has been 
marked will have the word “mark” 
next to that line.  The client can then 
use the left and right arrows next to the w



 
Any client viewing your output via TeleView will 
be able to save a copy of their notes, even if you 
choose not to make an ASCII or HTML copy of the 
transcript available.  The notes can be save in either 
ASCII or HTML format.  To save a copy of the 
Notes file, go to the viewer’s file menu, click Save 

Notes and then choose HTML Notes or ASCII Notes.  When the notes are saved, a file is 
created that contains each note, along with references to the lines where the notes were 
made. 
 
There are two options within the TeleView viewer for 
conducting word searches.  These options are “text 
search” and “hot words”.  Doing a text search gives 
the client the ability to look for specific words within 
the transcript.  To perform a text search, go to the 
Move menu and choose Find.  This will open a 
search box, where the client can enter the words they 
wish to search for, along with search parameters such 
as matching case and whole words.  Search parameters can be added to text searches by 
clicking the box next to the parameters the client wishes to include. Once text has been 

entered into the search field, 
click Find Next to begin the 
search.  When a match is made 
within the transcript, the viewer 
moves the transcript to the first 
match, as well as highlighting 

every match in black (text will appear in white).  By continuing to click Find Next, you 
will be able to view each match. 
 
Text searches can also be completed using hot words.  The 
hot words feature gives clients the option of having 
important words appear in red throughout the transcript.  
There is no maximum number of hot word searches that 
your client may perform.   
 
A hot words search can be performed in one of two ways.  
One option is to click the Hot Words button on the tool bar.  
The other option is to go to the Mark menu and click Hot 
Words.  With either option, a new window will open allowing the client to add any 
words that he or she wants to have marked as “hot words.”  Words can be removed from 
the list by highlighting a word and clicking the “remove” button or hitting “delete” on the 
keyboard. 



TeleView gives clients the option of 
making notes and marks within the 
transcript.  Notes can be associated with 
any line in the transcript.  In order to 
associate notes with a line, click on that 
line and press the Enter key.  A text box 
will open and the client will enter their 
notes into the box.  There is no character 
limit when making notes.  Once the client 

has finished making notes, they will click the 
OK button at the bottom of the text box to save 
the notes.  Once the client has saved their notes, 
an “N” will appear on the transcript to show that 
there are notes associated with that particular 
line. 
 
There is also an option available to delete notes.  To delete notes, click on the line that 
has the notes that need to be deleted, and press Enter to reopen the text box.  To delete 
the unwanted notes, highlight the text and press the Delete key.  Once notes have been 
deleted, click Ok.  The “N” next to that line will disappear.  If, before closing the text 
box, the client decides not to delete the notes, there is a way to recover the text.  To 
recover text, right click on the text box to open a drop down menu.  Once the drop down 
menu opens, choose Undo.  The text will reappear in the text box. 
 

Clients will also have the option of 
marking any line on the transcript.  
Clients can use this function to call 
attention to areas of a transcript they 
feel are important.  To mark a line, 
click on the line to be marked and 
press the spacebar.  A blue dot will 

then appear next to the marked line.  Removing a mark can be accomplished in the same 
way, click on the line and press the spacebar.  If a line is already highlighted, there is no 
need to click on the line before pressing the spacebar. 
 
Viewer Features 
 
TeleView supports a number of foreign language characters.  With TeleView, you can 
include Spanish, French, Italian, Portuguese and German characters in your transcript and 
they will be output to the TeleView viewer correctly. 
 



Among the options available with TeleView 
is the ability to change the viewer’s font 
type, size and color, the background and 
highlight bar color, as well as the colors for 
the Speaker, Answer and Question labels.  
To change the font or color settings from the 
viewer, go to the View menu and choose the 
Font Settings option.  This will open a font 
dialogue box, from which all of the above 
options can be changed.  You can also 
change the transcript line spacing from here.  
You may choose from single line spacing, line and a half spacing, or double line spacing,  
 
It is highly recommended that the default font, Dialog, be used because it provides a very 

Another option available with the TeleView viewer is to have 

timecodes and/or line num

ne feature that CART providers will find very 

ou have the option of locking the Chatback window to your server.  To do this, click on 

t this time, Chatback is only one-way communication.  The CART provider or Court 

clear view of the transcript.  However, you can use any font available on the computer, if 
a change is desired. 
 

timecodes and line numbers appear on the transcript. The 
default setting for the viewer is to have the transcript appear 
without timecodes or line numbers.  However, your clients 
have the option of turning on timecodes, line numbers or 
both.  To change timecode and line number preferences, go to 
the View menu and click Show Timecodes and/or Show 
Line Numbers, whichever is appropriate. (A check by either 
bers signifies that the checked item will appear on the 

transcript.) 
 
O
beneficial is Chatback.  Chatback allows clients to 
send messages to the CART provider or Court 
Reporter.  To send a message, the client presses 
Control + Enter, types the message in the text box that appears and then presses the 
Enter key.  A window will then open on the reporter or CART provider’s screen.   
 
Y
the lock at the top of the Chatback window.  With the Chatback window locked to the 
server, you will move the Chatback window whenever you move the server. 
 
A
Reporter cannot send messages to the client via Chatback. 



Many of the above mentioned features are accessible 
via TeleView’s optional toolbar.  The features 

available from the toolbar include Save as HTML, 
Follow Along, Find, Marks, Notes, Chatback, Hot 
Words and Font and Screen Settings.  The toolbar is 
turned on by default.  To turn off the toolbar, go to 
the View menu and remove the checkmark next to 
Show Toolbar. 
 
 
 

 
Ending a Session 
 
When your work for the day is finished, ending a session is simple.  At the beginning of 
the session, you clicked the Run Server button to start the server.  Once the server 
started, the button text changed to read Stop Server.  Click this button again to close the 
server and end the session. 
 
Stopping the server does not close the viewer on the client’s computer.  The transcript 
may be viewed as long as the viewer and browser window remain open.  Once the 
browser window or the viewer itself is closed, your clients will be unable to regain access 
to the transcript. 



Troubleshooting 
 
If you have encountered problems while using TeleView, the chart below offers some 
solutions for common problems.  This chart is not meant to be comprehensive; therefore 
it does not cover every problem that may occur.  If, after reviewing this chart, you are 
still having problems, please contact Advantage Software at 800-800-1759. 
 
Common  
Problems 

Possible 
Causes/Symptoms 

Possible  
Solution 

Client unable to 
view transcript 
and reporter is 
behind a router 

Reporter is unable to use Port 
80 behind the router. 

A port may need to be opened and forwarded on the router.  If 
this is a personal router, the user’s manual should contain 
instructions on opening a port.  Another resource for 
information on forwarding a router is PortForward.com 
(http://portforward.com/routers).  If this is a network router, 
you will need to contact your network administrator for 
assistance.. 
 
An easy way to check to see if the port is open and work is to 
use CanYouSeeMe.org (http://www.canyouseeme.org).  This 
website lets you check to see if a specific port is open. 

Client unable to 
view transcript 
and reporter is 
behind a firewall. 

Reporter is unable to use Port 
80 behind the firewall. 

A port on the firewall may need to be opened.  If this is a 
personal router, the user’s manual for your firewall should 
contain instructions on opening a port.  If this is a network 
router, you will need to contact your network administrator. 
 
Confirm client is putting the correct IP Address into the 
browser. 

Bad IP Address 

Use TeleView’s Confirm IP Address option, to make sure that 
the IP Address showing on the viewer, is the active IP 
Address. 
 
You can also use WhatIsMyIP.com (http://whatismyip.com) to 
confirm your IP address. 

Too many users trying to 
connect to web page 
simultaneously  

Have client wait a moment and try again 

Client not connected to the 
Internet 

Have client confirm they are connected to the Internet 

Client can’t find 
web page with 
viewer applet 

Reporter using a port other 
than port 80 (ex: Port 1234) 

The IP Address would need to be entered as 
http://123.456.789.58:1234 

Client able to 
connect to server, 
but no transcript 
appears. 

Pop-up blocker may be 
enabled. 

Have the client disable any pop-up blocking software on their 
computer. 
 
Have the client enable pop-ups within their browser. 

What client sees is 
not the same as 
reporter’s output 

You have chosen a CIC File for 
the server other than the one 
you are using for job output 

Close out the server and setup a new session using the correct 
output file 

Client unable to 
view transcript 
and client is 
behind a network 
firewall 

Port used by reporter is being 
blocked by the client’s firewall 

If this is a personal firewall, the user’s manual should 
instructions on unblocking a port.  If this is a network firewall, 
the client will need to contact their “Network Administrator” 
and have the port unblocked* 

*Advantage Software tech support cannot provide assistance in setting up a forwarding port or having a 
port unblocked.  You must contact the Network Administrator for assistance. 
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